
Beginning Microsoft Word XP 
 
Objective 1:  Become acquainted with the Microsoft Word XP environment. 

Toolbars 
Standard Toolbar

 
Formatting Toolbar 

 
 
Toolbars provide easy access to commonly used options.  The buttons on the 
Standard toolbar provide you with the ability to quickly open files, save, print, 
spell check, and cut/copy/paste among others.  The buttons on the Formatting 
toolbar provide you with the ability to apply common formatting options to text 
such as bold, italics, font, font size, and alignment.  The options found on 
toolbars can also be found in the menus shown at the top of the window.  The 
options located in the menus are often more detailed than those found on 
toolbars. 
 
To Display or Remove a Toolbar 

1. Click View on the Menu bar, and then point to Toolbars. 
2. Click on the toolbar that you wish to show or hide.  A check beside the name 

of a toolbar indicates that the toolbar is active or showing. 
 
Common Toolbars in Word XP include: standard, formatting, drawing, and web. 
 
NOTE:  In Microsoft Word XP2000, it is common for the standard and formatting toolbars to share 
a row to conserve space.  To separate the toolbars, click Tools on the Menu bar, and then click 
Customize.  Click the Options tab; deselect the Standard and Formatting toolbars share one 
row check box. 
 
Objective 2:  Apply formatting to text. 

Formatting Text 
Formatting adds a professional look to your text.  When you format text, you 
change its appearance by applying attributes ranging from font type to color. 
 
Several basic Formatting options can be found on the Formatting toolbar.   
However, you may wish to apply a more advanced formatting scheme to your 
text.  Advanced formatting includes:  superscript, subscript, shadow, all caps, 
strikethrough, etc.  Advanced formatting is located under the Format menu. 
 
To Apply Basic Formatting using the Formatting toolbar 

1. Highlight the text to format. 
2. Then select the formatting button of your choice from the Formatting toolbar.  
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To Apply Advanced Formatting using the Format Menu 
1. Highlight the text to 

format. 
2. Click Format on the 

Menu bar, and then 
click Font. 

3. Select the Font tab.  
4. Choose font, font style, 

size, color, etc. 
5. Then click OK. 

 
 
 
 
 
 
 
 
 
 
Objective 3:  Rearrange text using cut, copy, and paste. 

Copy & Paste, Cut & Paste, or Dragging? 
Word XP allows shortcuts to moving text around in a document, which is the 
biggest advantage of word processing as opposed to the old typewriter. Once 
you have a block of text highlighted, you may apply one of these keyboard 
shortcuts. 
 
 Helpful Shortcuts 

• Copy = Control + C 
• Cut    = Control + X 
• Paste = Control + V  (of course you cannot paste something until you have cut or 

copied) 
• Dragging = Using the mouse only 
 

These keyboard shortcuts are helpful IF you can remember what they are!  The 
Cut, Copy, and Paste functions can also be found on the Standard toolbar AND 
under the Edit menu. 
 
To Copy and Paste text within a Document  

1. Highlight the text you want to make a copy of. 
2. On the keyboard press the Control key and C key SIMULTANEOUSLY.  (or click 

the Copy button on the Standard toolbar or click Edit on the Menu bar and then click 
Copy.) 

3. Position your cursor where you want to place a copy of the text you highlighted in 
step 1. 

4. On the keyboard press the Control key and V key SIMULTANEOUSLY.  (or click 
the Paste button on the Standard toolbar or click Edit on the Menu bar and then click 
Paste.) 
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To Cut and Paste text within a Document 

1. Highlight the text you want to move. 
2. On the keyboard press the Control key and X key SIMULTANEOUSLY.  (or click 

the Cut button on the Standard toolbar or click Edit on the Menu bar and then click Cut.) 
3. Position your cursor where you want to move the text you highlighted in step 1. 
4. On the keyboard press the Control key and V key SIMULTANEOUSLY.  (or click 

the Paste button on the Standard toolbar or click Edit on the Menu bar and then click 
Paste.) 

Note:  Cutting a piece or block of text will REMOVE it from the original location.   
 
To Drag Text to another Position in a Document 

1. Highlight the text you want to move. 
2. Hold down the left mouse button within the highlighted text. 
3. Drag to desire area of document (you will see a small | ). 
4. Release left mouse button. 

 
 
Microsoft Word XP takes full advantage of the Windows 95/98/2000/XP 
environment; it allows you to simultaneously work with multiple documents.  You 
can work with two or more documents for comparing or editing, and you can 
easily cut, copy, and paste information from one document to another. 
  
To Copy/Cut and Paste Text between more than One Document 

1. Click File on the Menu bar, and then click Open.  (or use the Open button on 
the 
Standard 
toolbar.) 

2. Locate 
and 
highlight 
the 
document 
to open. 

3. Click the 
Open 
button. 

 
Repeat steps 1-3 
to open more 
documents. 

4. Click 
Window 
on the 
Menu bar. 

5. Click 
Arrange All.  (all of the documents will appear on your screen) 

6. Activate the window you want to copy from. (click on the title bar on the 
document window-it will turn blue)  

7. Highlight the text to be copied/cut. 
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8. On the keyboard press the Control key and C key / X key simultaneously.  (or 
click the Copy/Cut button on the Standard toolbar or click Edit on the Menu bar 
and then click Copy/Cut.) 

9. Activate the other window. 
10. Place the cursor where you want to paste information. 
11. On the keyboard press the Control key and V key SIMULTANEOUSLY.  (or 

click the Paste button on the Standard toolbar or click Edit on the Menu bar and 
then click Paste.) 

 
Objective 4:  Check the spelling and grammar in your document and enhance 
your word usage using the thesaurus. 
 
Word XP tries to correct both your spelling and grammar by making suggestions 
for what it thinks to be spelling and grammar mistakes.  Be very careful with this 
feature.  Some discipline specific words will not be found in the Word XP 
dictionary.  Word XP also has a built in thesaurus to help you find a word quickly. 

Spelling and Grammar 
By default, Word XP will automatically spell and grammar check your documents 
as you type.  A wavy red line will underline possible spelling errors.  A wavy 
green line will underline possible grammar errors.  
 
To Turn Automatic Spell and Grammar Check On/Off  

1. Click Tools on the Menu bar, and 
then click Options.  

2. Click the Spelling & Grammar 
tab. 

3. Select the options that best suit 
your needs, click OK.   

 
To Check the Possible Spelling or 
Grammar indicated by Wavy Lines 

1. Right click on the word or phrase 
that is underlined in either red or 
green. 

2. From the pop-up menu select the 
appropriate options by either 
choosing one of the suggestions or 
Ignore All.  

 
To Force Word XP to Spell and Grammar 
Check your Document 

1. Click the Spelling and Grammar button on the Standard toolbar. (or click Tools 
on the Menu bar then click Spelling and Grammar.) 

2. Word XP will cycle through your document looking for possible spelling and 
grammar mistakes.  You can choose whether to Ignore, Ignore All, Correct, Add, 
Change, etc.  Be sure to read the options carefully.  The options will change 
depending on whether the possible error is a grammatical one or a spelling one. 
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Thesaurus 
To Use the Thesaurus 

1. Highlight the word. 
2. Click Tools on the 

Menu bar, point to 
Language, and 
then click 
Thesaurus.  

3. In the Thesaurus 
meanings box, 
select the 
appropriate 
meaning, and then 
select the desired 
Synonym from the 
list. 

4. Click Replace. 

AutoCorrect 
Word XP automatically corrects common spelling and grammatical errors as you 
type.  For example, if you type the word  "teh", Word XP will change it to "the" as 
soon as you press the space bar.  You can also use AutoCorrect as a boilerplate 
text.  For example, instead of typing Georgia Perimeter College each time you 
need it, you can abbreviate by typing gpc and the Auto Correct option will 
automatically replace it with the entire name. As another example, you can type 
International Business Machines by setting up to replace the abbreviation of IBM. 
 
To use AutoCorrect 

1. Click Tools on the Menu bar 
then click AutoCorrect.  

2. Click the AutoCorrect tab. 
3. Type an abbreviated or 

commonly misspelled word in 
the Replace textbox. 

4. Type the correct word in the 
With textbox. 

5. Click Add to add to the list. 
6. Click OK to close the 

AutoCorrect dialog box. 
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Objective 5:  Apply headers and footers to a document. 

Headers and Footers 
Headers and Footers offer a simple and effective way add common elements to 
each page of a document.   You can add text, date, time and page number at the 
top and/or bottom of the page. 
 
To Add a Header or Footer 

1. Select View on the Menu bar then click Header and Footer. (This should open the 
Header 
and 
Footer 
toolbar.) 

 
 
 

Switch Between 
Header and Footer  
button

Insert 
Date 
button

Insert 
Page 
Number 
button

2. Use the buttons on the Header/Footer toolbar to add desired headers. (Time, 
Page Number, etc.) 

3. Use the Switch between Header/ Footer button to go to the Footer section. 
 
Objective 6:  Use Find and Replace to search for words/phrases, formats, and 
special characters in a document. 

Using Find and Replace 
The Find and Replace features allow you to search for or to replace specific text, 
formats, and special characters (such as spaces).  There may be times when you 
are working on a long document, and realize you have been spelling a word or 
name incorrectly.  It would take too long to locate each word individually.  The 
Find and Replace feature makes it easy for you. 
 
To Use Find  

1. Click Edit on the Menu bar then click Find. 
2. Type in the word you would like to find or use the More button to expand your 

search.  (See the information below on using the More button.) 
3. Click Find Next.  (You can edit at each occurrence.) 
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You can use the More button to expand or modify your search. 
 
In the Search box, select "All" to search the entire document, use down to search 
from the current location to the end, and up to search from the current location to 
the top 

 
• Match Case- instructs Word XP to find only uppercase or lowercase letters 
• Find Whole Words Only 
• Use wildcards for advanced search options   

o ?  =    wildcard  (Ex.  h?t may find hit, hat, or ham) 
o *  =    combination of characters (Ex. "Chair*" may find chaired, 

chairs, chairman) 
• Sounds Like (if you are not sure you spelled the word correctly) 
• Find all word forms (Ex. "sing" may find sung, sang, sing, etc.) 
• Format button will let you search for specific format occurrences. (Ex.  

bold, italics, Heading1, etc.) 
• Special button will let you search for a occurrences of special characters.  

(Ex. paragraphs, tabs, page breaks, etc.) 
 
To Use Replace 

1. Click Edit on the Menu bar then click Replace. 
2. The replace dialog box will appear.  (It is very similar to the Find dialog box.) 
3. Follow the same steps used with Find, but add text, formatting, or special 

characters in the Replace box. 
 
Objective 7:  Apply paragraph formatting and indents to a block of text or an 
entire document. 
 
Paragraph formatting includes line spacing options.  Line spacing refers to 
whether the block of text or document is single-spaced, double-spaced, 1.5 lines, 
etc. 
 
To Change Line Spacing 

1. Highlight the block of text 
you wish to change.  (If you 
wish to change the entire 
document, click Edit on the 
Menu bar, and then click 
Select All.) 

2. Click Format on the Menu 
bar then click Paragraph. 

3. Select the Indents and 
Spacing tab if necessary. 

4. In the Spacing section, click 
the Line spacing drop 
down list arrow and select 
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the appropriate spacing.  Then click OK. 

To Set Paragraph Indents 
1. If necessary, click View on the Menu bar and then click Ruler.  The Ruler should 

show at the top of the document.  The Ruler should have triangular shaped 
markers that indicated where the current indents are located.  The marker on the 
top of the Ruler shows where the first line of text in a paragraph will align.  The 
marker on the bottom of the Ruler shows where subsequent lines in a paragraph 
will align. 

2. Highlight the block of text you wish to change.  (If you wish to change the entire 
document, click Edit on the Menu bar, and then click Select All.) 

3. Using your mouse, click and drag the markers to the appropriate alignment.  (or 
click Format on the Menu bar and then click Paragraph. In the Indentation section, 
choose the location of the left and right indents. Then click OK.) 

 
To Create Hanging Indents 

1. If necessary, click View on the Menu bar and then click Ruler.  The Ruler should 
show at the top of the document.  The Ruler should have triangular shaped 
markers that indicated where the current indents are located.  The marker on the 
top of the Ruler shows where the first line of text in a paragraph will align.  The 
marker on the bottom of the Ruler shows where subsequent lines in a paragraph 
will align. 

2. Highlight the block of text you wish to change.  (If you wish to change the entire 
document, click Edit on the Menu bar, and then click Select All.) 

3. Using your mouse, click and drag the bottom marker to the appropriate 
alignment. (or click Format on the Menu bar and then click Paragraph.  In the 
Indentation section, click the Special drop down list. Choose Hanging and if desired 
choose the location of the hanging indent.  Then click OK.) 
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Objective 8:  Select page setup options for margins, paper size, and layout.  
Preview these selections prior to printing. 

Page Setup 
In the Page Setup box dialog box, you can select the options you prefer for text 
margins, paper size, and layout.  Page Setup will allow you to change your 
document from portrait to landscape and adjust your margins. 
 
To Use Page Setup 

1. Click to File on the Menu bar and then click 
Page Setup. 

2. Use the margin, paper size, paper source 
and layout tabs to customize your document, 
Click OK. 

 
 
 
 
 

Print Preview 
This includes a full-page view of a document's pages, so you can check the 
document before printing. 
 
To Preview a Document 

3. Click the Print Preview button on the Standard toolbar. (or click File on the Menu 
bar then click Print Preview.) 

4. Use the Zoom drop down arrow on the Print Preview toolbar to change the 
view to a larger/smaller image. 

 
5. Click the Close button to return to document. 
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